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What's New

Discover the latest enhancements and additions introduced in MineScape 2023

Update 6.

IMPORTANT: Before installing MineScape 2023 Update 6, please update the
System Services to the latest version, which is available for download in

the Distribution Portal. This update is mandatory to ensure a smooth installation

process and the optimal performance of MineScape. Attempting to install
MineScape without first updating the System Services will result in installation

issues.

.NET Upgrade

The Microsoft .NET Desktop Runtime has been upgraded to .NET 9 version.

Dragline

The Dragline App introduces major enhancements focused on scenario-based
design management, improved visual workflows, and expanded reporting
features. These updates enhance flexibility, streamline review, and improve

usability across dragline modelling.

Scenario and Replay

A new scenario framework allows users to manage multiple excavation strategies
within a block design. When starting a dragline design, users now select a
section, block, and scenario. A default scenario is automatically provided, and
additional scenarios can be added or edited using the Template Scenario Form,

accessible from the Dragline Tab.
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= Template Scenario

Template Scenario
D [Scenaio  Descripon |
1 sdsq Std_Sequence Standard sequence scenario
2 alsp Alter_Spoil_Loc Alternate spoil location scenario
3 loww Low_Wall_aAdv Advanced low wall scenario
4 redh ReducedHaul Reduced haul scenario
5 excw Ext_Cut_Width Extended cut width scenario
] B v ‘ Ok ‘ | Apply | | Cancel

List of Scenarios in the Template Scenario Form

Each scenario is saved as a scenario File (DRAGSCEN) linked to its corresponding
block replay (.DAT) and report (.RPT) files, which are generated automatically as
dragline works are performed. All files are now stored within the dragline Folder,

organised by section and block.

As part of this update, the Block Tab has been redesigned to support scenario-

based workflows. The tab now includes:
e A Scenario selector
¢ A Continuous Replay toggle
e Export and Import for block replay files

¢ A new Generate Option for creating custom operation replay files

Design  Perform  Block  Output  Help

Details

The Old Block Ta

Dragline Design Perform Block Output Help

: #* #
~y r - ~ = [ o ot
€« & (] (-] + = a | L] o il « WN
Save Finish Continuous Manage  Export Import  Dumps Brief Information New Finish Replay Undo Generate Tnm  Untrim  Define Import
Replay . Blast Profile

Repl.

The New

Details

Block Tab

Operations Surfaces [

Block replay files can now be exported or imported, allowing reuse of replay data
between sections and blocks. The new Continuous Replay Option plays all steps
in the replay file without interruption. When this option is turned off, dragline

pauses at every step and prompts for confirmation before continuing.
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Additionally, the new Generate Operation from Block Replay File Form allows
users to extract specific dragline elements or activities from an existing block
replay file to create a custom operation replay file. The form can be accessed by

clicking the Generate Button in the Block Tab within the Operations Group.

=2 Generate Operation from Block Replay File

Input

Block Replay File |sec01_c16_1 =
Dragline Element Element Content
Design_Line A Split_Area E

Lower_Area E_LOWER
Cut Selected D

Line_Selected DL_AND_CB
Cut_Area D EINISH

Split_Area E
Dump_Peak F
Dump_Peak G
Cut_Area H
Mine_Area |

Design_Line B
Design_Line C

Output

Operation File  hw_blast v

B B - | Ok ‘ | Apply | | Cancel

The Generate Operation from Block Replay File Form

Enhancements to the visual environment improve design interaction, spatial
awareness, and overall user experience. During replay, material movement
animation can be displayed in both 2D and 3D views, providing clear visual
feedback on how material is cut and placed throughout the design sequence.
When the main viewport is in 3D view, MineScape automatically switches to 2D
section view for design operations and returns to 3D view when complete. The
Place and Move Options now supports a 3D top-down view, improving
placement accuracy and reducing the likelihood of dragline collisions. The Show
Info Option displays the dragline name and coordinates, with adjustable Weight

and Colour.
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Moving Dragline with Show Info Toggled

The new Data View Option opens in a 3D bird's-eye perspective. When multiple
sections are displayed, visual overrides are automatically applied. The bird’s-eye
view retains its last-used settings when toggled, and resets to default when the

viewport is deleted.

The New Data View

Reporting

The Dragline Report Dock now includes additional columns (Hours, Easting,

Northing) and supports export to Excel for further analysis.
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& Dragline Report

The Enhanced Dragline Report Dock

Report files are now saved within the dragline Folder, organised by section and

block.

CAD

Project Elements onto Surface Above or Below

The Project Elements Form now supports projecting elements onto surfaces
above or below, expanding on the existing functionality to project to the nearest

surface when Expression or Surface is selected.

== Project Elements ? N OO - 0O X
Schema
Name v
Model Type e
Input
() Expression
® Surface L
O Elevation feet
O Height feet

Projection Angle
Sampling Density

Operation ]

Project

Project Up
= H- T Project Down“ Kpply ’ Cancel }

New Operation Options: Project Up & Project Down
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Import Microstation DGN

MineScape now supports importing MicroStation DGN files through the Import
Design Data Form or by right-clicking a design layer in the MineScape Explorer
Dock.

=2 Import Design Data

File Type Microstation DGN ‘B | New Layer
File Type Input i’ | Information ...
DAT MineScape Data B | Copy
Filename N u| o -
DM Datamine Legacy Delete ...
DMX Datamine Extended Search Layers [=] e
STR Surpac @ | Downgrade
DGDISIS  Vulcan Output -
, ) W | Import From ... * MineScape Data
DXE AutoCAD DXF/DWG Design File v perarte s . B | wmin t pe Data
DGN Microstation DGN B | Datamine Legacy
BUF Deswik DUF/DCF/VDCL L]iSingia Layer : B | Datamine Extended
ASC ASCIl d B |surpac
Options
XYZ Minex Are . Vulcan
SHP ESRI Shape File Line Weight Factor 0.25 | e—— . Pash DXF/DWG
Curve Vertex Density 20 Per Length Unit (Metres) Refresh ... B | Microstation DGN
. B | Deswik
Curve Minimum Vertices |20 / |Repair B |asc
[] Add Metadata B | Minex
B |EsRi Shape File
» B ‘ ok | ‘ Apply ‘ ‘ Cancel ‘

MineScape now Supports Importing MicroStation DGN Files

Below is a sample of an imported Microstation DGN file:

Imported Microstation DGN File
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Mesh

Added the Coordinate System Settings Option within the Point Cloud Group of

the Mesh Tab. This feature shares the same exact functionality with the

Coordinate System Settings Option in the Point Cloud Tools App.

Coordinate System Settings in the Mesh Tab
Stratmodel

Auto Populate Layer & Title Names in Contour Form

The Contour Form now supports automatic Layer and Title name population
when Surface or Interval is selected as the Data Source, and Interval is chosen
as the Input. The generated names combine the Interval and Attribute, and the

Layer name is truncated if it exceeds the maximum character limit.

= Contour - Surface or Interval

Setup

Contour
Data Source

Graphics Surface or Interval

Schema

Name
Model Type
Quality Model

nput Output

O Surface v Design File

@® Interval A2 M Layer A2_Totaloverburd | [_] Append

Attribute | Totaloverburden ~ ~ Title A2 Totaloverburden

bl =R ‘ ok | Apply ‘ [ Cancel

The Contour Form now auto populates the Layer and Title Names

UG Coal

Interactive Longwall

The new Interactive Longwall Tab in the UG Coal App makes underground

longwall design faster, easier, and more intuitive. Users can now create a

10
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complete longwall layout by simply drawing a single centre-line in the CAD
Window. MineScape automatically generates roads, pillars, and longwalls within
seconds. The design appears as a temporary graphic initially, allowing users to
modify parameters directly from the ribbon and see instant updates in CAD. This
allows for quick design iterations and lets users commit the final version to to the

nominated design file only when ready.

EY EERERER | S

g EEEE oo 0 B o OO Sucton ot
Temporary Graphics of Underground Longwall Layout

More UG Coal Enhancements

e Improved the speed when saving temporary graphics to nominated design

file in Interactive Pillars

e Added the Append Button in the Interactive Pillars Tab, allowing users to
choose between adding the temporary graphics to the existing

underground design or overwriting it

Commit

Append Button

n
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e Added a Settings Form in the Interactive Pillars Tab to define the limit
when rendering temporary graphics. The default is 1,000, which means
that if the temporary graphics contain more than 1,000 road elements
(headings), MineScape will display only simplified boundary panels as
temporary graphics. The form can be accessed by clicking the dialog box

launcher icon in the Main Panel Heading Group.

Number

Width 5

Main Panel Heading M=

Dialog Box Launcher to Display Render Limit Settings

— Settings ? N O — O X
Settings
Temporary graphics render limit | 1000
B B v | Ok | ‘ Apply | | Cancel

Render Limit Settings Form

Defect Fixes

Core

e Fixed a display issue where the menu that appears when clicking the

dropdown arrow in the Properties Dock was misaligned

e Fixed an issue where MineScape displayed incorrect Node Selected count
in the Properties Editor when multiple meshes were selected from the

MineScape Explorer

e Fixed a crash that occurred when opening files within the PDF3D Node

under the Images Folder in MineScape Explorer using an external PDF

viewer

12
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Fixed an issue where module output could be saved to another project

when multi-site settings include other projects.

Fixed an issue where a newly-created display definition wasn't selected

automatically

Fixed an issue where MineScape showed duplicated search results when

the ‘volumes’ keyword was inputted

Fixed an issue where selecting an app-specific node, for example Tempo

from Open Cut, did not persist after closing and reopening a project
Fixed an error that occurred when opening a design layer
Fixed an error that occurred when unloading the default TEMPLATES layer

Fixed an issue where a damaged design file with a corrupted second-level
header record could be opened but not closed by dfserver, leaving the file
handle locked. This update adds exception handling to log the error and

properly close the file.

Fixed an issue where searching for Underground Profile Node from the
MineScape Explorer search box did not apply the filter, causing all nodes to

remain visible

CAD

Fixed an issue where MineScape showed incorrect module title when

switching between CAD and other modules back and forth

Fixed an issue where changing a rubber band colour in the Graphics

Settings Form didn’t apply the new colour as expected

Fixed a misplacement issue of the ellipsis button in the Advanced »
Annotate Tab of the Format Painter Advanced Form. The button is now
positioned next to the Annotation Type Checkbox and is enabled when
the annotation type is set to Coordinate, CoordinatelLeft or

CoordinateRight.
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e Fixed an issue where users couldn’t attach .DXF files from other projects in
the Attach Reference Form. MineScape now shows extension names to

separate .DWG and .DXF files when attaching autocad files.

e Fixed an issue where users couldn't filter rows on a washability table in the
Table Editor

e Fixed an issue where vertices in Poly3D elements were not highlighted
when hovered over in CAD. This fix also improved the Poly3D and Poly2D

Forms by reducing empty space.

¢ Fixed an issue where exporting a layer containing black line elemenst to
.DXF or .DWG format caused the line to display in yellow instead of black

when reopened

e Fixed an issue where snapping to a segment during angle element

creation did not honour the snapped point’s elevation

Mesh

e Fixed missing feedback messages for the Fill Holes Option in the Solid

Mesh and Surface Mesh Groups in the Mesh Tab

Geology

e Fixed the handling of TMP files created by the STRATSLICE module so they
are now properly deleted after completion. This module is run from the

Cross-Section Form of the Stratmodel App.

e Fixed an issue where the Fixed Spacing Field in the Horizontal Alignment
Section of the Settings Tab in the Drill Hole 2D Graphics Form did not

retain the previously entered value

e Fixed an issue when re-loading a form specification in the Reserves
Calculate Volume Form after selecting a bench specification resulted in

incorrect form specification

e Fixed an error that occurred when running a log plot in GDB

14
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e Fixed a crash that occurred when opening the Quality Histogram Form in

Stratmodel multiple times

e Fixed an issue where the Drill Hole Import - CSV Form couldn't be resize

when the collar table exceeded 15 columns

e Fixed an issue where restoring a form spec in the Contour Form of the

Stratmodel App didn't automatically populate the Layer Field

e Fixed an issue where pressing Enter after entering a display definition

name in the Contour Form did not confirm the input as expected

Surface Engineering

e Fixed an issue in the form that appeared when clicking the Clear Option in
the Drilling Tab of the Drill and Blast App, where the form title was too
long and overlapped the icon. The form title has been changed to Clear

Blast Object.

e Fixed a display issue where two checkboxes in the Pit Projection Node

within the Generate Solids Form overlapped with each other

e Fixed an issue where the progress bar for opening a project overlapped

with the Open Design File Form

e Fixed an error that occurred in Dragline after the Open Design File Form

was opened twice

e Fixed an issue where the Open Design File Form wasn't loaded

automatically when loading the Dragline App

Drone Surveying

e Fixed an issue where pointing to the same coordinate on two LAS files

displayed different Z values

15
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Plot Designer

Fixed an issue where MineScape didn't validate empty input values when

creating a Title Block in Plot Designer

e Fixed an issue that occurred when copying an excel data containing
unsupported fonts. Plot Designer now applies a default font to ensure

proper display of such data.

e Fixed an issue where the Save As Button remained enabled even when the

plot window was no longer active

e Fixed an issue where the Paper Dropdown list in the Paper Size Form

showed empty entries

Removed

e Removed the on-context menu button from the Edit Project Units Form

to improve interface consistency
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